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Background

The United States (U.S.) Navy identified the need for development of a
survey data-collection system that fully meets U.S. Navy Marine Species
Monitoring (MSM) data standards. The objectives were to streamline data-
collection procedures, minimize manual data-management requirements,

and increase the standardization and repeatability of data-collection efforts.

In response to this need, HDR developed a survey toolkit called COMPASS
(Cetacean Observation and Marine Protected Animal Survey Software).
COMPASS is designed to be an integrated survey data-collection and data-
management system to facilitate work conducted during MSM surveys.
HDR'’s survey toolkit integrates current mobile and web technologies to
allow efficient real-time collection, processing, reporting, and delivery of
marine species data.

COMPASS includes a mobile platform for data collection in the field; a web
portal to design, plan, and execute surveys and access data products; and a
server-hosted database management system for quality control (QC), team
collaboration, and preliminary data processing/reporting. The surveys
conducted within the MSM program include a variety of data-collection
scenarios and technologies. This preliminary version of the COMPASS
system addresses the needs for the most common survey types: shore-
based (theodolite), vessel-based, and aerial-based. The data-collection
routines for each survey type are designed to maintain consistency with the
U.S. Navy’s Data Standard (developed by Naval Facilities Engineering
Command Atlantic and HDR, Inc.), which specifies field names, aliases, data
types, measurement units, and descriptions for data that are collected in
the field. Each data-collection scenario will use some subset of fields
specified in the Data Standard.

Installation & Update

Downloading the App
1. OntheiPad, open Safari (web browser).
2. Navigate to the COMPASS web portal:
https://compass.hdrgateway.com

3. Login using provided credentials, or create an account.
Once logged in go to the “Get Mobile App” page.

5. Tap the COMPASS app icon. *Note: if you see a message
referencing iOS system software version you will need to update
your iPad to a newer version of iOS before installing.

6. Answer “Install” when asked if you want to install the app.

Mobile App

The app will now download and install on the iPad home screen. Depending
on how many apps are installed, the app may install on the second page of
the home screen. Swipe left to see additional home screen pages.



Enable the app
iOS 9 and newer requires an additional security requirement to allow
enterprise apps to run. To enable COMPASS, do the following:

Open the Settings App

Tap the General item

Scroll down to Device Management, and tap it
Find the entry for HDR Inc, and tap it

Tap Trust
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Loading Baselayers and Basemaps
Once installed, baselayers (non-editable vector layers) and basemaps (raster
tile caches) can be loaded into the app by doing the following:

1. PlugiPad into a computer with iTunes installed.

Once the iPad drivers are installed and the device appears in iTunes,
click the device icon.

3. Select “Apps” from the side menu in the “Settings” section

. Scroll down to the “File Sharing” section and find the COMPASS app.

5. Click the app icon and a list of files will appear in the “COMPASS
Documents” window.

6. Add basemap (.tpk) files by dragging them into this window.

7. Add baselayer (.geodatabase) files by dragging it into this window.

8. Once all copy processes have completed, eject the iPad and unplug
it from the computer.

9. Ifthe app is already running on the iPad it may be necessary to
force-quit it (double tap home button, swipe app up off top of
screen) and re-launch it by tapping the app icon.

10. Baselayers and Basemaps will now be available in the Layers tab.
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The “COMPASS Documents” window also contains the geodatabase files for
collection of field data. These will be stored in a folder with the name of the
project. These should not be altered or moved unless instructed to do so by
technical support staff.

Updating the App

Updates may be provided periodically to provide additional functionality or
to fix reported issues. If asked to update the app, follow the exact same
procedure listed in the “Downloading the App” section. The updated
version of the app will be installed over the existing version and all settings
and data will remain in place. Once the app has finished updating it can be
re-opened from the iPad home screen.



App Operation

App Layout

The COMPASS data collection app uses a simplified layout consisting of a
main map view displaying spatial data over aerial imagery or other
basemaps as well as several tabs across the top of the screen containing
different types of data that can be collected. The app also includes a side-
menu to access ancillary app functions and settings.

Side Menu

The side menu provides access to ancillary features of the app not directly
related to field data collection. This menu appears in the upper left corner
of the screen as a series of 3 horizontal bars. A red badge with a white
number may appear over the side menu if the device currently has collected
data that has not been synchronized to the host server. This number
represents the number of new or edited features in the local device
database. Tapping the menu icon will open the side menu.

| Q Search - Species




Search Tab
The search tab helps locate records quickly by

Pad =

searching the entire database of records.
Collected observations can be searched by the
value entered into the name field.

A search will return a table of results. Tapping on
of the items in the results table will zoom the
map to that feature and highlight it in yellow.

Tapping the small “x” in the search field or
tapping Cancel will clear the search results and
remove any highlight.

Layer Tab

The Layer controls the visibility of various layers in
the app. Layers will be displayed in one of four
categories in the layer table; Editable Features,
Basemap Features, Tile Cache Layers, and App
Bundle Tile Cache.

Editable Features
Editable Features include the layers available for
data collection. Tap these layers to toggle visibility

Basemap Features

Basemap Features include all the non-editable
vector layers included in the app. Tap these layers
to toggle visibility

Tile Cache Layers

Layers in this section include the TPK files loaded
onto the iPad via iTunes (see above). TPK files may
be loaded to provide a specific basemap for a
project or geographic area. All valid TPK files
loaded into the App’s file sharing window will
appear in this section of the menu. Only one tile
cache can be displayed at a time. Selecting an
item from this section will activate it and turn off
the previously selected tile cache.

App Bundle Tile Cache

This section contains the default global tile cache included with the app.
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Editable Features
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Re-Sighting
Sighting

Focal Follow
Vessel

Other (Type In)
Trash
Vegetation

Bouy

*  BiopsylLog

TaggingLog

*  GPS Track Points
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GPS Track Line

Basemap Features

None found

Tile Cache Layers

None found

App Bundle Tile Cache
DefaultCache
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Settings Tab
The settings tab contains ancillary app functions.

Position Logging

This switch toggles position logging on or off.
Position logging records the location of the iPad at
a set interval, creating a series of track points as
well as a track line documenting the current effort
status.

Logging Interval

This defines the interval in seconds between track
log points. The default interval for aerial surveys is
20 seconds, and the default for vessel surveys is 60
seconds. You may override this default with you
own preferred logging interval, however be aware
that a smaller interval will result in a larger dataset
and negatively impact device battery life.

Date Filter
The date filter is used to limit the data displayed in
the map and the list views. Tapping the field will

bring up a data chooser. Tapping the “X” symbol on

the right edge of the field will clear the date filter.

Survey Management

Position Logging
Logging Interval
Date Filter

Survey Management
App Authorization

Version: 1.0.385

20
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This row provides access to the Survey Management window. This window

is used to control and configure surveys on the iPad, as well as sync data

with the database.

App Authorization

This item opens the App Authorization window, used to authorize the app

for use and log in to COMPASS.

Survey Management Window

The Survey Management Window
displays the surveys currently
available for download and use in
COMPASS. Information in this view
is updated from a master project
database and can be updated by
clicking the green sync button in the
upper right corner.

Surveys downloaded and ready for
use on the devices are indicated by
the “Downloaded” label. A
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downloaded project can be activated by tapping the white circle on the left

edge of the table next to the project name. The current active project is

indicated by a green checkmark.

al Shore Station Location D
This project is configured for shore

e station survey. If you know a precise
Latitude, Longitude, and Elevation for
the Shore Station enter them below. If

R youdon't have known coordinates you [
can use the GPS when you collect an

observation

N D
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Shore Survey: Station Location Pop-up

o When selecting a shore survey as the active
project a pop-up window will appear giving you
the opportunity to enter specific coordinates and
elevation values for your shore station location.
You can also access this window by tapping the

window when collecting observation data.

Survey Detail View

Tapping a project in the Project Management Window will show detailed
information in the Project Detail View. This view provides information on

the project and also facilitates download and sync of project data.

“Platform Position” row in the Position Calculation



A project that has not yet been < Project Management Export [y0c]
downloaded to the device will

Project Name

display a green “Download” button
Status

in the upper right corner.

Created By

Created On

Once downloaded to the device, Sorvios Path
the Project Detail Window will Database Name

Project ID

display a green “Sync” button in the
upper right corner. Tapping this <.

button will transmit collected data Foogs Comies
to HDR servers. Dedicated Platform

The Project Detail View will also display an orange “Export” button. This
button can be tapped at any time to create a CSV export of all data in the
survey database. These exports will be stored in a folder in the Documents
directory of the Compass app and are accessible via the iOS Files app

Authorization View

The Authorization View is used to authorize the app for use, and to log into
the COMPASS system. Account credentials can be entered and verified by
tapping the “Update” button.

ESRI Runtime Code (Provided by Program Manager):
10110437 LIOHSX009

Runtime Status: License is valid - Read/Write

ESRI Runtime Code
This code authorized the Esri

Runtime SDK for use. The Runtime

fin Account Credentials:

michael.a davis@hdrinc.com

SDK provides mapping and
geospatial data management
capabilities used by COMPASS to
record data and display maps.

The Runtime code will be

EOENS_ ke @sri

downloaded directly from the
COMPASS server and verified
automatically.

COMPASS Account Credentials

Entering your user credentials for the COMPASS system into these fields will
allow the iPad to contact the web portal and determine which surveys you
are authorized to use. Without credentials, no surveys will be available on
the device and data cannot be collected.

Once your credentials have been verified you will see a red “Log Out”
button on the screen. Logging out will disable access to projects.

Authorization Errors

You may occasionally experience errors when authenticating your account
with the COMPASS server. If this occurs, please note the error message
received and report it to COMPASS technical support.

Map View

Carrier ¥
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The map view is the main spatial interface for the app. It displays editable
layers, vector baselayers, as well as a base tile cache. The display of these
layers can be controlled in the Layers tab of the side menu.



The dialogue box at the bottom of the map view shows basic GPS data
regarding position, course, and speed. The “status” display is a timer for
your current effort status — which can be helpful for time on/off effort or
conducting different types of effort (e.g. focal follows).

Navigation

Map navigation is via a drag-to-pan or pinch-to-zoom action. Double-
tapping the screen will zoom in one level, and single-tapping the screen with
two fingers at the same time will zoom out one level.

Location Display

Tapping the GPS button in the upper right corner of the app will toggle
location display. This activates the internal iPad GPS or, if connected to an
external GPS receiver, activates the connection to the external GPS and
activates the data quality status display.

The GPS button will display with a green color when connected to the
internal iPad GPS and a blue color when connected to an external receiver.

Map Orientation

When the GPS is activated, tapping the compass button next to the side
menu in the upper left corner of the app will toggle the map view between
map mode and navigation mode. When in map mode the map is oriented
“North Up”. Switching to navigation mode changes the map to orient to the
current direction of travel.

Scale Bar

A scale bar is provided in the lower left corner of the map display. This scale
bar provides real-time scale information as the map is panned or zoomed.
The bar is configured to be 1-inch long on iPad displays and displays the
equivalent map distance as measured on the ground.

Quick Collect Shortcuts

Carrier ¥ 130 PM 1 00% - ¢
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While in the map view you can quickly collect a new Effort, Environment,
Observation, or Other record by pressing the corresponding segment button
for 2+ seconds. Doing this will trigger a pop-up window with a blank entry
for the selected record type.

Quick Collect Observations

When adding Observations through the Quick Collect shortcut an
abbreviated version of the observation form will be presented.

New Quick Observation

SIGHTING LOCATION

O Platform Position

SIGHTING DETAILS
Sighting Number 5
LocalTime 12/16/2018 12:18:55 PM
Count Total Best 1
Scientific Name

Common Name

Sighting Notes

This form displays the location of the sighting with no offset from the
platform. It also will default to a count of one, and will maintain sticky
values for species separate from the main Observation collection form.
These observations will show up in the main Observation List and will be
numbered in sequence for the sighting number count.



Effort
Effort List View

Pad ¥ 12:31PM 7 100% I+

05/26/2016 12:30:44 PM

end survey day
05/26/2016 12:30:33 PM
wheels down

05/26/2016 12:30:22 PM
wheels up

05/23/2016 10:15:04 AM

start survey day

The Effort tab provides a list of collected effort log entries documenting the
type of survey occurring and the crew configuration. This list is sorted in
descending order by date, with the newest records on the top of the list.

To collect a new effort record, click the “+” button in the upper right corner.

To access details for an existing effort log entry, tap the record.

Effort Details
Pad ¥ 12:31PM 100% SIS +
< Back m
DateTime

Effort Status
Flight Of the Day
Leg ID

Leg Number

Leg Notes

Navy Directed Leg
Survey Info

Effort ID

Observer

Aft

Left

Right

Pilot in Command
Second in Command
Recorder

Crew Configuration ID

The Effort Detail View displays information about the survey status, as well
as the crew configuration. Tap “Edit” to make changes to the form, and
remember to tap “Save” when done! If you do not wish to save edits, you
can tap the “Cancel” button.

Sticky Values

The Effort Detail form will retain several “sticky” values that are
remembered by the app and automatically populated for new records. For
Effort records this includes:



- Effort Status
- Crew Names in the configuration section

These sticky values are updated every time a record is saved, and will be
reset when changing surveys.

Crew Names

Crew names are drawn from the authorized users added to the project as
well as names added to the “Other Users” section of the survey
configuration section of the Compass web portal. These users will show up
in the pick list, but do not have access to survey data or resources in the
Compass web portal. If additional authorized users or “Other Users” are
added to the survey in the Compass web portal they will show up after the
next data sync.

Environment

Environment List View

Pad ¥ 12:31PM 100% 2

05/26/2016 12:31:12 PM

The Environment tab provides a list of collected environmental observation
log entries documenting the information on the current weather conditions
and sea state. This list is sorted in descending order by date, with the
newest records on the top of the list.

To collect a new environment record, click the “+” button in the upper right
corner.

To access details for an existing environment log entry, tap the record.

10



Environment Details

Pad ¥ 12:31PM 100% D ¢
 Back En
DateTime

Beaufort Scale - Left (0 - 12)
Beaufort Scale - Right (0 - 12)
GlarelLeft

GlareRight (0 - 100)

Percent Cloud Cover - L (0 - 100)
Percent Cloud Cover - R (0 - 100)
Visibility-Left

Visibility-Right

Swell

Swell Direction

Wave Height

Wind Direction

Wind Speed

Environmental ID

The Environment Detail View displays information about weather and sea
state conditions. Tap “Edit” to make changes to the form, and remember to
tap “Save” when done! If you do not wish to save edits, you can tap the
“Cancel” button.

Note: while not all surveys have a “left” and “right” observer, the MSM Data
Standard was created to cover all possible data collection scenarios. If only
one environmental record is needed you can select left or right when
creating a survey in the web portal but do not need to have both for mobile
data collection.

Sticky Values

The Environment Detail form will retain several “sticky” values that are
remembered by the app and automatically populated for new records. For
Environmental records this includes:

- Beaufort State (Left & Right)

- Glare (Left & Right)

- Percent Cloud Cover (Left & Right)
- Visibility (Left & Right)

- Swell Direction

- Wind Direction

- Wind Speed

- Wave Height

These sticky values are updated every time a record is saved, and will be
reset when changing surveys.

Observation

Observation List View

Pad ¥ 2:49 PM 100% 23

Risso's dolphin 05/26/2016 12:32:15 PM

SEERC 05/25/2016 10:16:49 AM

The Observation tab provides a list of collected marine mammal observation
log entries. This list is sorted in descending order by date, with the newest
records on the top of the list.

To collect a new observation record, click the “+” button in the upper right

corner.

To access details for an existing observation log entry, tap the record.

11



Observation Details

Carrier & 3:52PM 100% B 4
Existing Observation Save

SIGHTING LOCATION

€3 Platform Position

€ Enter Bearing, Distance, and Heading to Calculate Sighting Location

FOCAL FOLLOW OBSERVATIONS - SWIPE TO DELETE

Save Record to Add Focal Follow

SIGHTING DETAILS

Observation Type - Tap to manage resightings SIGHTING .
Sighting Number
LocalTime 07/18/2017 04:07:21 PM

Depth (Feet) - value will be stored in meters
Cue

Birds

Scientific Name

Common Name

Mixed Group Sighting

Species Confidence

Behavior

Behavior Event

Species Hauled Out

Max Body Lengths to Neighbor

Min Body Lengths to Neighbor

The Observation Detail View displays information about the
sighting/observation Tap “Edit” to make changes to the form, and
remember to tap “Save” when done! If you do not wish to save edits you
can tap the “Cancel” button.

Sticky Values
The Observation Detail form will retain severa

Ill

sticky” values that are

remembered by the app and automatically populated for new records. For

Observation records this includes:

- Species Common Name
- Species Scientific Name

These sticky values are updated every time a record is saved, and will be
reset when changing surveys.

12



Position Calculation Pop-Up

When collecting a new observation, the app will automatically determine
the observer location and open the Position Calculation pop up window.
This window allows the observer to enter the required distance
measurements to determine the location of the observation.

Platform Position

This section displays the location of the observation platform as determined
by the iPad GPS. This will also include the elevation and heading if the
position data is of a high enough quality. If not, these field may be blank, or
populated with a value of -1. In this instance the observer will need to
manually enter these values using other instruments such as a compass or
altimeter. If no value is entered the animal position will not be calculated.

Observation Data

The instrument and measurements used to locate the observation are
entered in this section. The type of instrument can be chosen from a pick
list and the angle measurement entered, along with a bearing to the
observation.

Once all this information is entered, the distance to the observation will be
calculated when the observer hits “Save”. When this is done the app will
automatically use the bearing and distance to calculate the observation and
generate a spatial point at that location. If an error is made in data entry
this form can be revisited later at any time, and the entered data edited.
Each time the data is saved, the location of the observation point will be
recalculated. Additionally, adjusting the bearing and distance from the
original observation will force the observation position to be re-calculated.

Sticky Values
The Position Calculation form will retain severa

I”

sticky” values that are
remembered by the app and automatically populated for new records this
includes:

- Optics Type

If surveying in shore station mode there are additional sticky values

including:

Position Calculation El m

Platform Position

O Platform Position

Reference Angle True (deg) 98.47
Reference Angle Magnetic (deg) 87.34
Platform Elevation 35

C) Reference Point
Observation Data

Optics Type

Raw Horizontal Theodolite Angle - D.. 196d 49m 48s
Raw Vertical Theodolite Angle - DMS 95d 20m 24s
Radial Distance to Animal - Meters 374.80
Sighting Location

€ Animal Location

Animal Heading (deg)

- Laser, Estimate
0 Platform Lat/Long
0 Platform Elevation
0 Platform Heading
0O Bearing
O Distance

° Platform Position (Platform
Latitude, Platform Longitude)

. Platform Elevation

. Reference Point

These sticky values are updated
every time a record is saved, and will
be reset when changing surveys.

Required Fields

Depending on the type of
instrument used for the observation,
specific fields are required to

successfully perform an offset calculation. These fields are:

- Big Eyes, Clinometer, Fujinon 7x50

0 Platform Lat/Long
0 Platform Elevation
0 Platform Heading
O Bearing

0 Vertical Angle

- Theodolite

O Platform Lat/Long
0 Platform Elevation
0 Vertical Angle

13



O Horizontal Angle

Theodolite

Observations can be collected using an attached theodolite. COMPASS
currently supports Sokkia DTS5 series Theodolites using the L2-DB9V
thunderbolt to serial converter cable from Redpark Product Development
(www.redpark.com).

When collecting data in a project configured for shore or vessel survey the
Position Calculation pop-up window will display an additional button in the
title bar. Tapping this button will send a message to the theodolite
triggering a response. The response message will then be parsed into the
Vertical and Horizontal Angle fields.

Theodolite Reference Point

COMPASS supports the entry of a
reference location for theodolite offset
measurements. This location can be

Reference Point Location

f you know a precise Latitude amd
B Longitude of a reference location enter
them below. Top MAP 10 choose the
point Interactively

known location, or by tapping a location on i = e

75938232

entered via a Latitude/Longitude of a

the map.

To modify the reference angle settings tap
the “Reference Angle” row while editing —
data in the Position Calculation view. Enter
a Lat/Long into the fields, or tap “MAP” to

interactively choose the reference point on

a map.

Focal Follow

The Observation Detail form includes a section to record Focal Follow

entries. Once a new Observation
record is saved, the observer can add
focal follow records by tapping the
“Add Focal Follow” row in the table.
Tapping this row will open a new Focal
Follow form functionally similar to the
Observation Detail form. Once the
position of the Focal Follow
observation is calculated and
appropriate attributes recorded in the
form, the focal follow records will
display in the Observation Detail form
in descending order by date, with the
newest observation at the top.

Re-Sightings

Below the Focal Follow section is the
Sighting Details section. The first row
in this section specifies the observation
type. An observation can be toggled
between “Sighting” and “Re-Sighting”
by changing the toggle in this row.
Tapping this row will open the Re-
Sighting manager allowing you to add
and delete re-sighting records.

Tapping the “+” button will prompt
you to add a new Re-Sighting or choose
an existing Sighting record from that
day to re-assign as a Re-Sighting.

Carrer ¥ T oox -

< Back Existing Observation

) Platform Position

.} Enter Bearing, Distance, and Heading to Calculate Sighting Location

< #dd Focal Follow Point
FUo
DivePeduncle arch
FUON
FUD
Biow
Dive/Peduncle arch
Owve/Peduncie arch

Blow

Blow

Observation Type - Tap to manage resightings
Sighting Number

LocalTime

Re-Sightings
Swipe to Delete

Magepiem novesangise. 03/24/2017 03:09:14 PM
fesmenohas 03/242017 10:40:25 AM

A whoke

Megacaera noveseniise 03/24/2017 09:12:08 AM

Add Re-Sighting
Would you like to add a new Re-
Sighting, or select a current
Observation to designate a Re-
Sighting?

New

Existing

Cancel

14



Existing sightings can also be re-classified as Re-Sightings by toggling the
switch from “Sighting” to “Re-Sighting”. Doing this will open a window
prompting you to choose the parent sighting from the previously collected
observations for that day.

Save Record to Add Focal Follow

FUD

(null)

SIGHTING DETAILS
Observation Type - Tap to manage resightings SIGHTING @

QinhtinAa Niimhar

Similarly, a Re-Sighting can be switched to a Sighting by toggling the switch.
Doing so will remove the record from the list of associated Re-Sightings and
assign it a daily sighting number.

Other Sightings
This type of sighting may include vessels, debris/trash, vegetation, or any
other item the crew would like to document.

Sightings are captured in a similar manner to Observations, as described
above. The sighting location and vessel position will be documented along
with the date and time, sighting type, and notes.

15



Troubleshooting

Map Display

When surveying or collecting field data you may occasionally run into a
situation where the map is not displaying the data you expect to see. In
these instances be sure to check the following:

- Make sure the correct project is active in the Survey Management
window.

- Make sure the Date Filter is set to the correct day in the Settings
Menu

- Make sure the layers are set to visible in the Layers Tab of the side
menu.

Bluetooth

External high-precision GPS devices connect to the iPad via Bluetooth.
While these connections have proven to be reliable, Bluetooth can
experience interference from other devices that operate in the 2.4Ghz
spectrum. If you are experiencing trouble with the connection to the
external GPS, try the following:

«« > »

< — ) ° n

Swipe up from the bottom of the screen to display the quick-access toolbar.
Find the Bluetooth symbol (center top) and tap it once to turn Bluetooth off,
then once more to turn Bluetooth back on. This will force external devices
to reconnect.

App Stability

Compass is still under active development and as such may crash or shut
down from time to time. In addition iOS, the operating system on the iPad,
may close down the app unexpectedly to free up resources and conserve
battery life. Compass is designed to account for these shut-downs by
storing data in a non-volatile state (database) and preserving the state of
the app.

If Compass shuts down unexpectedly immediately re-open the app and it
should return to the state it was in when the shutdown occurred. This will
include re-starting location tracking. In addition if the shutdown was due to
a bug in the system a report will be sent to the developers with debugging
information the next time a network connection is available.
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Data Sync

Data collected on the device needs to be synchronized to the host server
periodically to archive it, and to make it available for other users to review
and Quality Check. The app will indicate that new or edited data is stored
on the device by displaying a red badge on the icon for the side menu
(upper left corner of the map view screen). This red badge indicates the
number of non-sync’d new features or edits present on the device.

The sync process can take 2-5 minutes to run under normal circumstances.
If you experience long sync times it may be due to a slow network
connection. If you experience trouble when trying to sync or get an error
message, please check the following:

1. Make sure the iPad is connected to a Wi-Fi network. This can be
checked in the Settings app.

2. Make sure the iPad can access the internet. Do this by opening
Safari (web browser) on the iPad and visiting
http://www.google.com or https://apps.hdrgateway.com. If you can

connect to these sites, the app should be able to reach the HDR
server.

3. Toggle Wi-Fi off and back on by opening the quick-access toolbar
(see Bluetooth troubleshooting) and tapping the Wi-Fi icon once to
turn it off, and again to turn it back on.

4. If you encounter an error message related to authentication it may
be necessary to re-enter your credentials in the Authorization View
and tap “Update”, then return to the Project Details and try the
sync again. (see page 7)

5. If the above steps fail to fix the issue, it may mean there is a
network issue somewhere between the wireless access point and
the HDR server. It may be necessary to back data up locally and
delay sync until network connectivity can be restored. See the
backup section under Data Management for details.

*Note: Data sync in ArcGIS Server works in a “last-in-wins” manner,
meaning the most recent sync or commit will overwrite existing data in the
database. Specifically, if information about a sighting, observation, etc. is
edited on the mobile device and sync’d after edits or changes have been
made to data in the web portal it may cause those changes to be written
over.

To mitigate the risk of inadvertently writing over data edits it is best-practice
to only edit data via the web portal once it has been checked in from the
mobile app. In cases where data edits must be performed on the mobile
device it is important to coordinate with the rest of the survey team.

If data is inadvertently synced over changes or edits it is possible to restore
the lost data from the database archive, however this will require contacting
COMPASS technical support to accomplish.

Data Sync Best Practice
Managing data between the mobile device and web portal is most
successful if you follow these guidelines:

- When collecting data or editing existing data on a mobile device
sync the survey at the beginning and end of the session.

- Stick to editing collected data via either the mobile device or the
web portal (not both) during a single session.

Data Management

Basemap Creation

COMPASS supports adding user-created basemaps (.tpk files) to provide
background imagery and contextual information. Once loaded, users can
switch between basemaps at any time by choosing one in the Layers tab.
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Esri provides comprehensive instructions on creating a Tile Package (.tpk) in
ArcMap here: http://desktop.arcgis.com/en/arcmap/10.3/map/working-

with-arcmap/about-tile-packages.htm3

The basic steps to create a tile package for your project include:

e Create an ArcMap document containing the layers you want to
include. This can include both raster and vector layers, but vector
layers included in a tile cache cannot be individually controlled or
identified. The ArcMap document should follow these guidelines:

0 Web map services and other online data sources cannot be
included in the map document*

0 The map projection must be set to Web Mercator (Auxiliary
Sphere)

0 Remember that this map will display at multiple zoom
levels. Set your zoom levels in ArcMap to ArcGIS
Online/Bing Maps/Google Maps

0 View your map document at each of the zoom levels you
want to include and make sure the styling and labeling are
working the way you want them to.

e Export a.TPK using the Create ArcGIS Runtime Content tool under
File -> Share As

*There are options available if you need to include an on-line imagery or
data source in your tile cache. Contact the COMPASS support team if you
require this for your project.

Baselayer Creation
COMPASS supports adding user-created non-editable vector layers to
provide additional context to surveys. Examples may include survey area

boundaries, hazard areas, buoy locations, etc. Baselayers will be loaded into
COMPASS and can be individually turned off/on in the Layers tab.

Esri provides comprehensive instructions on creating an ArcGIS Runtime
Geodatabse
here: http://desktop.arcgis.com/en/arcmap/10.3/map/working-with-

arcmap/creating-arcgis-runtime-content.htm

The basic steps to add custom map layers include:

0 Create an ArcMap document containing the layers you want to
include. The ArcMap document must meet these requirements:

0 All source data must exist in the same folder (shapefiles) or
geodatabse (feature classes)

0 All source data must be in the same projection

0 One map layer per source dataset (can’t have multiple map
layers pointing at the same feature class)

0 Do notinclude a background layer (imagery, street map,
etc.). Only vector layers. On the device the background will
be provided by tile cache files.

0 Keep your layer styling and labeling simple. The app will do
the best it can to mimic the styles you use in your map, but
the app doesn’t support complex symbology very well.

0 Specify a primary display field. This is the field the app will
display when you tap one of your baselayer features.

0 Set the projection of your ArcMap document to Web
Mercator (Auxiliary Sphere)

0 Enable runtime export tools (Customize -> ArcMap Options ->
Sharing ->Enable Runtime Tools)

O Export a baselayer geodatabase (.geodatabase) using the Create
ArcGIS Runtime Content tool under File -> Share As
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Daily Backup

It is important to back up the iPad daily after field data collection is
complete. It is generally recommended you back up your iPad BEFORE
sync’ing data to the server each night. Doing this is easy following the steps

below:

1. Connect the iPad to a computer with iTunes installed

2. Select the iPad when it appears in the iTunes side menu

3. Click the Summary tab

4. Find and click the “Back up Now” button

JB@ .- @ GISDEV1

@ GISDEVT PO

32G8 - ¢ Ipad

ot Manbr, MPKEAAAFI 80 St R —
7 Apps check for an update again on 7/14/15.
E:'i ;::S Check for Update Restore iPad...
] TV Shows
@ Podcasts
AR Books Backups
Photos
@ info Automatically Back Up Manually Back Up and Restore

iCloud ) KUp your P tt

11 Music om; c(;mp;ﬂsr Back Up Now Restore Backup...
E Movies A full backup ¢ Pad w r
1TV Shows. Encrypt local °°°K‘fp L‘,""‘F’f‘c.:“,’?i_‘ to this computer
AR Books paci : »
[¥] Audiobooks

+v 3

Apps ] 14.34 GB Free Sync

iTunes will archive the entire contents of the iPad to a backup file. In case
of a lost or damaged iPad, the backup can be restored to another device and
all collected information retrieved.

Database Retrieval

If you experience difficulty syncing data from the app, or other issues
prevent normal operation of the data collection app, we may ask you to
retrieve the database of collected field data from the device for archive and
diagnosis. In this circumstance, retrieve a copy of the database from the
device by doing the following:

Drag 16 rearrange apps, screens, asd pages.

File Sharing
> i-a:am Apps COMPASS Documents
8 e g e oprrr
TV Shows a7 AppCooker lax_t028.geodstabase
Podcas )
Audiobook: m
| Photos B“"‘"
e Bus Monitor
;‘.l Music oy
“'“‘S”M @ Collectos
'_‘ e coumss
fome Contact
3C5uvwr
| ) 17308 Froe sme  EEZE
1. Connect the iPad to a computer with iTunes installed
2. Select the iPad when it appears in the iTunes side menu
3. Select “Apps” from the side menu in the “Settings” section
4. Scroll down to the “File Sharing” section and find the COMPASS

app
Click the app icon and a list of files will appear in the “COMPASS

o

Documents” window

Find the folder with the same name as your project
Choose this folder and select the “Save To” button
Save the files to a central location on the computer
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If requested, zip these files in this folder into a single archive and
email them to the provided address

Auto Archiving

While you are collecting data with the Position Logging option turned and
the GPS active the app will automatically archive your local database every
5-10 minutes. These archive files will be stored in the folder for the active
survey. If needed they can be accessed via iTunes or the iOS Files app.
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Managing Multiple iPads on a Survey

Compass is currently configured to support using a single iPad to record
data for a survey. While our future plans include enabling simultaneous use
of multiple iPads on surveys, please do not do so at this time.

If you wish to use multiple iPads for redundant data collection it is
important to remember to only sync the data from one iPad at the end of
the survey day. After verifying the sync completed successfully, archive the
data on the second device and download a new copy of the database for
that project. This will ensure that duplicate data is not logged for the survey
that might affect reporting and effort calculations.

In the event of a hardware failure or other event it may be necessary to rely
on data from a backup or secondary device to “fill a hole” in the data
collected by the primary iPad. In this case it is best to contact Compass
support staff so we can assist you in checking in your survey data.
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